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Date Variable Substitution 

Date fields have a powerful feature known as “variable substitution”. When creating an 

equation with a date field, you have the option of entering a date variable into the Contents 

field rather than an actual date. This is extremely useful in specifications that are to be run on 

a periodic basis. For example, you may need to create a report that lists the performance 

reviews due during the current week. Assuming the week is the first week of January 2007, 

you would enter the equations as shown below. 

Appraisal Next Date   >= 01-01-2007 AND  
Appraisal Next Date   <= 01-07-2007  

This works fine until the following week. Then the equations have to be modified to work for 

that week. Using variable substitution you would enter the equations as shown below using 

the two date variables: START-OF-WEEK and END-OF-WEEK. 

Appraisal Next Date     >=    START-OF-WEEK  AND  
Appraisal Next Date     <=   END-OF-WEEK  

These equations may never need to be changed because the correct dates are always 

substituted for you.  

Date substitution variables can be entered directly into the Contents fields or can be selected 

using the Date Variable popup, which is the regular popup button  to the right of the Date 

popup button . When you use the Date Variable popup, a list of the date variables is 

displayed in a screen like the one shown below. Each of the date variables is described in 

detail in the sections below.  

Date Variables with Between and Outside Operators 

The Contents field is supported by the applicable table when you use a field that is supported 

by a table. When you use a field supported by a table or a date field and you also use the 

Between or Outside operators, the Between or Outside screen is used to specify the two 

values to be used with the Between and Outside operators. Each of the fields is supported by 

either the appropriate table or date popups. Once you have entered the two values, the 

appropriate phrase is returned to the Contents field. For example, if you have used date 

substitution variables for a date field, the phrase shown below would be returned. 

START-OF-MONTH AND END-OF-MONTH 

Day-Based Date Variables 

The date associated with the day variables is derived at the moment it is requested. Thus, if 

you are working near midnight, you will get different results with the day-based variables 

depending on whether it is 11:59 PM or 12:01 AM. Consider the query shown below. 

Hire Date = TODAY 

If you run a report with this query prior to midnight on June 1, 2002, it will list all of the 

employees with hire dates of June 1, 2002. If you run a report with this query just after 
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midnight on June 2, 2002 (thinking it is still “today”), the report will actually list all of the 

employees with hire dates of June 2, 2002. 

TODAY  
Defines the date associated with today. This variable is extremely useful when generating 

“year-to-date” reports. For example, if you wish to generate a report listing those employees 

who have been hired for the year to date, you would use the equations listed below. 

Hire Date >= START-OF-YEAR  AND  
Hire Date <= TODAY 

Regardless of when you run this report, the report will always contain a list of the employees 

hired since the start of the year. 

TOMORROW 
Defines the date associated with tomorrow. It works very much like the TODAY variable. 

YESTERDAY 
Defines the date associated with yesterday. It works very much like the TODAY variable. 

THIRTY-DAYS-BACK 
Defines the date associated with the day 30 days ago. This variable is very useful when used 

in conjunction with the TODAY variable to limit records to those with dates within a 

backward rolling 30-day range. For example, if you wish to generate a report listing those 

employees who have been hired in the last 30 days, you would use the equation set shown 

below. 

Hire Date >= THIRTY-DAYS-BACK  AND  
Hire Date <= TODAY 

Regardless of when you run this report, the report will always contain a list of the employees 

hired in the last 30 days, even if the 30-day period overlaps year ending dates or month 

ending dates. 

THIRTY-DAYS-FORWARD  
Defines the date associated with 30 days from now. This variable is very useful when used in 

conjunction with the TODAY variable to limit records to those with dates within a forward 

rolling 30-day range. For example, if you wish to generate a report listing those employees 

who have performance reviews due in the next 30 days, you would use the equation set 

shown below. 

Appraisal Next Date >= TODAY AND  
Appraisal  Next Date <= THIRTY-DAYS-FORWARD 

Regardless of when you run this report, the report will always contain a list of the employees 

with review dates in the next 30 days, even if the 30-day period overlaps year-ending or 

month-ending dates. 

Note: The “THIRTY-DAY” variables should not be confused with the START-OF-MONTH, 

END-OF-MONTH variables. The START-OF-MONTH variable is tied to the first day of the 

current month. That day could be between 1 and 30 days ago. If you use the START-OF-

MONTH variable on the second day of a month, the query will actually look back just 2 days 

and not the 30 days you were expecting. The END-OF-MONTH variable is tied to the last 

day of the current month. That day could be between 1 and 30 days from today. If you use the 

END-OF-MONTH variable on the tenth day of a month, the query will actually look forward 
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just 20 days and not the 30 days you were expecting. To ensure a true rolling 30-day cycle, 

use the “THIRTY-DAY” variables. 

SIXTY-DAYS-BACK 
Defines the date associated with 60 days ago. This variable can be used just like the 30-day 

variable described above. The only difference is that the cycle is 60 days rather than 30. 

SIXTY-DAYS-FORWARD 
Defines the date associated with 60 days from now. This variable can be used just like the 30-

day variable described above. The only difference is that the cycle is 60 days rather than 30. 

Note: The “SIXTY-DAY” variables should not be confused with the START-OF-PRIOR-

MONTH, END-OF-NEXT-MONTH variables. The START-OF-PRIOR-MONTH variable is 

tied to the first day of the prior month. That day could be between 1 and 60 days ago. If you 

use the START-OF-PRIOR-MONTH variable on the second day of a month, the query will 

actually look back just 32 days and not the 60 days you were expecting. The END-OF-

NEXT-MONTH variable is tied to the last day of the next month. That day could be between 

1 and 60 days from today. If you use the END-OF-NEXT-MONTH variable on the tenth day 

of a month, the query will actually look forward just 50 days and not the 60 days you were 

expecting. To ensure a true rolling 60-day cycle, use the “SIXTY-DAY” variables 

NINETY-DAYS-BACK 
Defines the date associated with 90 days ago. This variable can be used just like the 30-day 

variable described above. The only difference is that the cycle is 90 days rather than 30. 

NINETY-DAYS-FORWARD 
Defines the date associated with 90 days from now. This variable can be used just like the 30-

day variable described above. The only difference is that the cycle is 90 days rather than 30. 

Note: The “NINETY-DAY” variables should not be confused with the START-OF-

QUARTER, END-OF-QUARTER variables. The START-OF-QUARTER variable is tied to 

the first day of the current quarter. That day could be between 1 and 90 days ago. If you use 

the START-OF-QUARTER variable on the second day of the second month of the quarter, 

the query will actually look back just 32 days and not the 90 days you were expecting. The 

END-OF-QUARTER variable is tied to the last day of the current quarter. That day could be 

between 1 and 90 days from today. If you use the END-OF-QUARTER variable on the tenth 

day of the second month of the quarter, the query will actually look forward just 50 days and 

not the 90 days you were expecting. To ensure a true rolling 90-day cycle, use the “NINETY-

DAY” variables. 

ONE-YEAR-BACK 
Defines the date associated with one full year ago. This variable can be used just like the 30-

day variable described above. The only difference is that the cycle is one year rather than 30 

days. 

ONE-YEAR-FORWARD 
Defines the date associated with one full year in the future. This variable can be used just like 

the 30-day variable described above. The only difference is that the cycle is one year rather 

than 30 days. 

Note: The “ONE-YEAR” variables should not be confused with the START-OF-YEAR and 

END-OF-YEAR variables. The START-OF-YEAR variable is tied to January 1 of the current 

year. That day could be between 1 and 365 days ago. If you use the START-OF-YEAR 
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variable in the middle of the year, the query will actually look back only half as far as you 

intended. The END-OF-YEAR variable is tied to December 31 of the current year. That day 

could be between 1 and 365 days from today. If you use the END-OF-YEAR variable in the 

middle of the year, the query will actually look forward half as far you intended. To ensure a 

true rolling year cycle, use the “ONE-YEAR” variables. 

USER-DAYS-BACK-1 
Defines the date associated with a user-defined number of days ago. The number of days 

actually used is defined on the Date Variables tab of the Enterprise Setup process. 

USER-DAYS-FORWARD-1 
Defines the date associated with a user-defined number of days in the future. The number of 

days actually used is defined on the Date Variables tab of the Enterprise Setup process. 

USER-DAYS-BACK-2 
Defines the date associated with a user-defined number of days ago. The number of days 

actually used is defined on the Date Variables tab of the Enterprise Setup process. 

USER-DAYS-FORWARD-2 
Defines the date associated with a user-defined number of days in the future. The number of 

days actually used is defined on the Date Variables tab of the Enterprise Setup process. 

Week-Based Date Variables 

The week-based variables come in pairs, one for the start of a given week and one for the end 

of the given week. The “start” day in these variables is associated with the Monday of that 

week. The “end” day in these variables is associated with the Friday of that week. 

The date associated with a week variable is derived at the moment it is requested. Thus, if 

you are working near midnight on Saturday night, you will get different results with the day-

based variables depending on whether it is 11:59 PM on Saturday night or 12:01 AM on 

Sunday morning. Consider the query shown below. 

Hire Date >= START-OF-WEEK 

If you run a report with this query prior to midnight on a Saturday, it will list all of the 

employees with hire dates during the week ending at midnight. If you run a report with the 

same query just after midnight (early Sunday morning), it will list all of the employees with 

hire dates during the week that just began. 

START-OF-WEEK 
Defines the date associated with Monday of the current week. The current week begins at 

12:01 AM on Sunday morning.  

END-OF-WEEK 
Defines the date associated with Friday of the current week. The current week ends at 11:59 

on Saturday night. 

START-OF-NEXT-WEEK 
Defines the date associated with Monday of the following week. 

END-OF-NEXT-WEEK 
Defines the date associated with Friday of the following week. 
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START-OF-PRIOR-WEEK 
Defines the date associated with Monday of the prior week. 

END-OF-PRIOR-WEEK 
Defines the date associated with Friday of the prior week. 

Month-Based Date Variables 

The date associated with a month variable is derived slightly differently than its “Week-

based” relative. It is not derived at the “moment” it is requested. Rather, it is derived when 

you log into People-Trak. Thus, if you are working near midnight on the last day of the 

month, you will get the same results with the month-based variables even if you cross 

midnight and pass into a new month during the current edit session. If you wish to reset the 

month variables because you are working late, simply exit People-Trak and then come back 

in. 

START-OF-MONTH 
Defines the date associated with the first day of the current month. 

END-OF-MONTH 
Defines the date associated with the last day of the current month. 

START-OF-NEXT-MONTH 
Defines the date associated with the first day of the next month. 

END-OF-NEXT-MONTH 
Defines the date associated with the last day of the next month. 

START-OF-PRIOR-MONTH 
Defines the date associated with the first day of the prior month. 

END-OF-PRIOR-MONTH 
Defines the date associated with the last day of the prior month. 

Quarter-Based Variables 

The quarter-based date variables in People-Trak are based on the following dates. 

Quarter 1: January 1 to March 31 

Quarter 2: April 1 to June 30 

Quarter 3: July 1 to September 30 

Quarter 4: October 1 to December 31 

The date associated with a quarter variable is derived when you log into People-Trak, like the 

“Month-based” variables. Thus, if you are working near midnight on the last day of the 

quarter, you will get the same results with the quarter-based variables even if you cross 

midnight and pass into a new quarter during the current edit session. If you wish to reset the 

quarter variables because you are working late, simply exit People-Trak and then come back 

in. 
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START-OF-QUARTER 
Defines the date associated with the first day of the current quarter. The date will be January 

1, April 1, July 1, or October 1. 

END-OF-QUARTER 
Defines the date associated with the last day of the current quarter. The date will be March 

31, June 30, September 30, or December 31. 

Year-Based Variables 

The year-based date variables in People-Trak are based on the calendar year that starts on 

January 1 and ends on December 31. 

The date associated with a year variable is derived when you log into People-Trak, like the 

“Month-based” variables. Thus, if you are working near midnight on the last day of the year, 

you will get the same results with the year-based variables even if you cross midnight and 

pass into a new year during the current edit session. If you wish to reset the year variables 

because you are working late, simply exit People-Trak and then come back in. 

START-OF-YEAR 
Defines the date associated with January 1 of the current year. 

END-OF-YEAR 
Defines the date associated with December 31 of the current year. 

START-OF-PRIOR-YEAR 
Defines the date associated with January 1 of the prior year. 

END-OF-PRIOR-YEAR 
Defines the date associated with December 31 of the prior year 

Date Substitution Examples 

Date Substitution variables can be used in any combination. Together they should meet a 

wide variety of filtering needs. A few examples are presented below. 

Employment Status = TERMINATED  AND  
Status Date >= START-OF-YEAR  AND  
Status Date <= TODAY  

This filter includes all employees terminated since the start of the current year. This would be 

a typical query for terminated employees for year to date. 

Employment Status = NEW-HIRE  AND  
Status Date >= START-OF-MONTH  AND  
Status Date <= END-OF-MONTH  

This filter includes all employees hired during the current month. This would be a typical 

query for new hires for the current month. 
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Date Variables and the Scheduler 

Date substitution variables are crucial to the use of the scheduler. Any document that uses 

dates and is to be scheduled should use date variables whenever possible. Otherwise, the 

scheduled report will not move with the dates. For example, if you schedule a “review due 

next week” report with hard-coded dates, the report will be obsolete after the first week. The 

document will show up in the scheduler, but will be the wrong report. If you used “week” 

date variables in the report and schedule the report to be run weekly, the report will always be 

timely. 

Using the Custom Tab 

The Custom tab is used to look up records when you do not know an applicable value for one 

of the fields on the Basic tab, or when you wish to create a specific query based on a single 

field. You can use this tab to create a simple user-defined query using the field name for the 

field you know and the value that you have. When the Custom tab is selected, the screen 

shown below is displayed.       

Queries are formed from three components: a field name, an operator, and a comparison 

value. Together, the three components form an equation of the following format. 

Field Name   Operator   Contents 

Simple Query Examples 
To select those employees that are female, enter the query shown below, with Gender as the 

Field Name, = as the Operator, and Female as the Contents.  

Gender = Female 

When this lookup query is performed, the value of the Gender field for each record will be 

compared to the value “Female”. If the Gender field contains “Female” the record is included 

in the lookup. 

To select those employees who are greater than 50 years of age, enter the query shown below. 

Age > 50 

When this lookup query is performed, the value of the Age field for each record will be 

compared to the value “50”. If the Age field contains a value greater than 50, the record is 

included in the lookup. 

To select those employees with a pay rate less than or equal to $50,000, enter the query 

shown below. 

Pay Rate <=  50000 

When this lookup query is performed, the value of the latest Pay Rate field for each record 

will be compared to the value “50000”. If the Pay Rate field contains a value less than or 

equal to 50,000, the record is included in the lookup. 

Using the Advanced Tab 

The Advanced tab is used to look up records when you wish to specify multiple query 

equations and/or generate complex queries. The Advanced tab uses the standard query grid.  
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You can create a query using all of the advanced query capability of People-Trak. The query 

that you develop on the Advanced tab is used for a single lookup and is then discarded. If you 

wish to create and use an advanced query more than once, consider using the Favorites 

feature as defined in the following section. 

Lookup Favorites 

A lookup favorite document is not really a document, but is created and used like one. A 

lookup favorite document does not produce a printed result, but is used with the Lookup 

feature and Quick Search to produce “favorite lookups” that can be used over and over again. 

The Lookup Favorites screen has two tabs. The Specification tab is used to record the name 

of the document and its categories. The Query tab is the standard query tab that is used to 

determine the records to be retrieved.  

Using the Options Tab 

The Options tab is used to span companies when looking up records and to specify if only the 

highlighted record in the search results should be opened. When the Options tab is selected, 

the following fields are displayed:  

Span Companies on Search  
Allows you to specify whether or not the current lookup should span companies. Select the 

check box to span companies. Clear the check box to not span companies, which only shows 

records from the current company. This check box is defaulted to cleared whenever a new 

lookup is started. If spanning is done, a Company column is included in the search results. If 

you prefer to have the Lookup in a module defaulted to Span Companies on Search, you can 

specify these settings in Module Setup. Spanning is turned off for non administrative users 

and therefore cannot be turned on in lookup for these users, even if the default is set to span. 

 

Note: When spanning, if you select a record from the search results that is from another 

company, you are asked if you want to switch to that other company. If you say “Yes”, you 

are automatically switched to the other company and the records from the other company (or 

just the one record if Single Record is selected) that were in the current search are opened as 

the current record group with the selected record active. This is necessary because you cannot 

edit a record from company B while in company A. The same is true if you are spanning and 

select a record from the search results that is from the current company.  Only the qualifying 

records in the current company are opened as a group (or just the one record if Single Record 

is selected).  

Single Record on Select  
Allows you to specify whether or not current lookup should only open the highlighted record 

in the search results. Select the check box to only open the highlighted record in the search 

results. Clear the check box to open all records in the search results. This check box is 

defaulted to cleared whenever a new lookup is started. If you prefer to have the Lookup in a 

module defaulted to Single Record on Select, you can specify these settings in Module Setup. 
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Freeform Reports 

The Freeform Report document type allows you to enter a SQL statement and a series of 

captions to create reports that you could not otherwise create. Normal use of this feature 

requires specific knowledge of SQL and internal knowledge of the People-Trak database. 

The Freeform Reports feature bypasses all field security. If a user is allowed to create a 

Freeform Report, he or she can access any field within People-Trak. For this reason, there are 

special security settings for the Freeform Reports feature.  

 

Note: You will only see Freeform Reports as an option on the Documents menu when either 

the Create Freeform Reports or Run Freeform Reports check box has been selected for your 

user. 

The Freeform Reports option uses a three-tab screen. The Specification tab is similar to the 

Adhoc Report screen and is used to define basic information about the document. The SQL 

Statement tab contains a single text box for entering the SQL statement. The Report Captions 

tab contains a grid for entering captions and formatting formulas.  

Specification Tab 
The Specification tab is used to define setup information for the Freeform Report.  

The specification tab of a freeform report is very similar to the specification tab of an adhoc 

report. The only differences are that a freeform report is always using auto formatting and is 

always in columnar format.  

SQL Statement 
The SQL Statement tab is used for entering the SQL statement that will generate the report. 

Report Captions 
The Report Captions tab is used to enter the caption and format of each field on the report. 

Cluster Reports 

The Cluster Report document type allows you to run several documents together as a group, 

without having to select and run each document separately. This feature is particularly 

valuable if you tend to run a series of documents at the end of each month, or merely on a 

frequent basis.  

The Cluster Report option uses a two-tab screen. The Specification tab is used to record the 

name of the cluster and the categories for the cluster. The Documents tab is used to define the 

documents to include in the Cluster Report.  

Specification Tab 
The Specification tab is used to define setup information for the Cluster Report. The 

specification tab of a cluster report is very similar to the specification tab of an adhoc report.  

Documents Tab 
The Documents tab is used to define the documents to include in the cluster report. Cluster 

reports cannot be selected. 
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Running a Cluster Report 

To run the cluster report, use the Run Cluster Report option on the File menu or the Run 

Cluster Report button on the Tool Bar. Each document will be processed independently, and 

you may see the progress bar for each.  

When the documents are complete, they are merged together and then shown within the 

Document Viewer. The documents are discrete within the Document Viewer. The page 

counter on the Tool Bar reflects the total number of pages in the document, but each 

document’s pages are numbered from 1 to the total number of pages in the document. Font 

settings, alignment, spacing, and grid lines are all unique to each document. If you choose to 

print the document, one stream of pages will be printed. 

Because it is possible to mix the types of documents in a cluster report, the Navigation Bar is 

not available for Form/Letter/Label documents and the Output to Spreadsheet option is not 

available. The Cluster Report feature is intended to provide an easy way of outputting several 

documents; it is not intended to be used for interactive purposes. 

Standard Reports 

The Standard Reports screen has two tabs. The Specification tab is used to record the 

document name, categories, template to be used and sort order. The Query tab is the standard 

query tab and is used to record the query equations that determine which records are to be 

included in the report.  

Document Properties 

Spanning Tab 
The Spanning tab is used to activate company spanning. Documents are normally produced 

using a query that selects records from the current company. With company spanning, you 

can cause any document to select records from a collection of companies, not just the current 

company. For example, if you wish to run a report that includes records from both the active 

and the archive databases, you can specify these databases with the company spanning 

feature. Whenever this document is run, it will collect applicable records from both 

companies. 

Company spanning is not used by default. In other words, if you do not specify company 

spanning, the current company is used.  

In Freeform reports, spanning is done by default so no Spanning tab is available. 

Note: Spanning is only available to Administrators for security purposes, so when non-

administrators run a document that spans, they will only see information for the current 

company and based on their given security. 

 



  

 

  

 
Lesson 8 

Date Variable Substitution 
 
 

Contents 

Tutorial 8.1 – Entering Date Variables 12 
Tutorial 8.2 –Appraisals Due Example 14 

 

 
This lesson covers how to use date variables to make reports more versatile and more 

flexible. 

Tutorials 
Entering Date Variables: shows how to use the Date Variable popup to select date variables 

for use in the Contents column of the Query grid. 

Appraisals Due Example: demonstrates a “real-world” example of how to use the date 

substitution variables. 
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Tutorial 8.1 – Entering Date Variables 

Date variables cannot be keyed directly into the Contents column. They must be selected 

from the Date Variables table. We will learn how to do this in this tutorial. 

1. On the Documents menu, select Adhoc Reports. 

2. On the Tool Bar, click the New Adhoc Report button to create a new document.  

3. On the Report Definition tab, enter the following Field Names: Full Name and Hire 

Date. 

4. On the Query tab, enter Hire Date as the first field. Set the Operator to “>”.  

 

Your cursor should now be in the Contents column. Two popup buttons are displayed. 

The first is the Date Calendar button, which is used to select a date from a calendar. The 

second is the Date Variable button, which is used to select a date variable from a list of 

variables.  

5. Click the Date Variable popup button.  

 

The list of date variables, sorted by categories, is displayed. 

 

Let’s assume you are looking for those employees hired since the beginning of last 

month.  

6. Select the Months category. 

 

The choices appearing to the right of the category all now pertain to months. 

7. Select START-OF-PRIOR-MONTH from the displayed list.  

8. Run the report.  

 

You can see that there were no new employees hired since the beginning of last month. 

Let’s tweak the report a little bit and run it again. 

9. In the Contents field, click the Date Variable popup button. Select the Years category. 

Select START-OF-PRIOR-YEAR.  

 

The equation will now select those employees with a hire date since the start of last year.  

10. Run the report.  

 

If there are any employees with hire dates since the start of last year, they will be listed. 

11. Set the AND link on the first row. Then add Hire Date on the second row. Set the 

Operator to “<”. Use the Date Variable table again using the category Years and select 

END-OF-PRIOR-YEAR.   

12. Run the report.  

 

This sample report will now list those employees with a hire date between the start of last 

year and the end of last year.  
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13. Close the Document Viewer. 

 

There are two anniversary operators for use with date fields that make creating scheduled 

anniversary reports a breeze. They would typically be used with date variables, so let’s 

take a look at those now. 

14. In the first row of the query, change the Operator to Anniv and the Contents to 

TODAY. Remove the AND link and delete the second query row. 

15. Run the report. 

 

If there are employees that have a hire date with the same month and day as today, they 

will be listed.  

16. Close the Document Viewer. 

 

If you want to just compare the month, use the Anniv-M operator. 

17. Change the Operator to Anniv-M and run the report. 

 

If there are employees that have a hire date with the same month as today, they will be 

listed. 

18. Close the Document Viewer and the Adhoc Reports screen.  

19. Continue with the next tutorial. 
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Tutorial 8.2 – Appraisals Due Example 

This tutorial guides you through the creation of a “real world” report: a Appraisals Due 

report. The report will be demonstrated for various date periods. 

1. Create a new Adhoc Report.  

2. On the Report Definition tab, enter the following three fields: Department Name, Full 

Name, and Appraisal Next Date. Set a Sort Type of Eject on the Department Name 

field. Set a Sort on Full Name. Set a Sort on the Appraisal Next Date, but use 

Descending order. Set “*”as the Row Modifier on the Appraisal Next Date. 

3. Run the report. 

 

The report should list all next appraisals for each employee sorted by next appraisal date. 

Each time the Department Name field changes a new page will start. This report is 

designed for distribution to each manager with a list of the employees who are due for 

appraisals over a specified period. At this point, the report includes all employees and all 

appraisals. Let’s correct that with a query. 

 

One typical version of this report is run at the end of each week and is designed to list the 

appraisals due the following week. It would use the query equations as shown in the next 

step. 

4. On the Query tab, enter the following equations: 

 

Appraisal Next Date    *   >=  START-OF-NEXT-WEEK AND 

Appraisal Next Date   *   <=  END-OF-NEXT-WEEK 

5. Run the report.  

 

You should see a report listing employees that have an appraisal due next week. 

 

This report has an error. It shows all next appraisals for any employee who has an 

appraisal due next week.  Let’s fix that. 

6. On the Report Definition tab, change the Row Modifier for the Appraisal Next Date 

field to “=”.  

7. Run the report. 

 

This basic report can be modified to produce reports that look ahead over any of the 

available periods. The most useful for Performance Appraisals are the next month, and 

the next 30 days. The appropriate equations are shown below. 

 

Appraisal Next Date   *   >= START-OF-NEXT-MONTH AND 

Appraisal Next Date   *   <= END-OF-NEXT-MONTH 

 

Appraisal Next Date   *   >= TODAY                   AND 

Appraisal Next Date   *   <= THIRTY-DAYS-FORWARD 

 

Note that the second pair of equations makes use of the TODAY variable to start the 30 

day period from today through a day 30 days from now.  

 

Another useful variation of this report is a version that looks backward for a topmost next 
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appraisal that is prior to today. This would represent appraisals that were scheduled and 

not performed. To create this report, you would change the Modifier on the Query tab to 

be blank or 1 and then set the date variables to START/END-OF-PRIOR-WEEK or 

START/END-OF-PRIOR-MONTH. 

8. Close the Document Viewer, the Adhoc Reports screen and the Explorer.  

9. This concludes this tutorial and lesson. 
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This lesson provides a basic introduction to derived fields, how to select a derived field for 

use in report and demonstrates how to use a query statement on that report.  

Tutorials 
Derived Field and Query on a Report: shows how to select a derived field for use in report 

and demonstrates how to use a query statement on that report. 

Changing Periods for User Date Variables: demonstrates how to change the periods used 

for a user date variable. 

Derived Field Attendance Report: reviews using a derived field and query for an 

attendance report. 
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Tutorial 9.1 – Derived Field and Query on a Report 

Before moving on to using advanced query methods, we need to explore the concept of using 

and querying derived fields in an adhoc report.  

1. Create a new Adhoc Report using what you have learned in prior lessons and give your 

new report the name Address Block.  

2. For the Explorer Category and Category, select Personal. 

3. Under the Report Definition tab, bring up the Select Field screen. Under the All Fields 

category, move down the list of fields until you see the Address Block field and 

highlight it.  

Before selecting this field for our report, notice that the field ID is quite different from 

the field ID’s we have seen before. It starts with DERIVED and is followed by an 

underscore and a number. This is because Address Block is a derived field. 

Derived fields are fields that are derived from one or more existing fields (including 

existing derived fields) within People-Trak. Some derived fields may be used for 

calculations, such as figuring out a pay increase, and others combine multiple fields such 

as address information into a single field. Derived fields are not stored in the database; 

they are derived when they are used on a document. Let’s see what happens when we run 

a report with the Address Block field. 

4. Select the Address Block field and run the report. 

While we selected a single field, we can easily see that much more information was 

returned to us. This particular derived field contains the employee’s full name as well as 

their address. It is ready to be used on a letter or label and eliminates the need to enter 

each field individually on a commonly used group of fields. 

Say we wanted to run this same report, but only for the employees that live in Fallbrook. 

We have seen that the Address Block ‘contains’ the name of the city that each of our 

employees live in, so our query can be based on the contents of the derived field. 

5. Under the Query tab enter the equation shown below and then run the report: 

 

Address Block  Contains Fallbrook 

Our Fallbrook residents are returned to us with their address block fields verifying that 

they are indeed from Fallbrook.  

Now that we have a better grasp of the concept of querying with dervied fields, we can 

see it in action in the next few tutorials. 

6. Close all screens without saving changes. 

7. Continue with the next tutorial. 
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Tutorial 9.2 – Changing Periods for User Date Variables  

In the next tutorial, we will be using a derived field that has been created specifically for our 

attendance policy. This particular derived field calculates the sum of the hours used over a 

specified number of days in attendance history for the illness account. Currently we are 

looking for violations that occurred in the past 45 days.  

The user date variable, USER1-DAYS-BACK, is used in the derived field formula. Let’s 

make sure this particular date variable is indeed set to 45 days. 

1. On the Setup menu, select Enterprise Setup.  

2. Click the Date Variables tab.  

The Date Variables tab shows the user date variables that exist in People-Trak and allows 

you to change the periods associated with them. The system date variables (i.e. TODAY, 

TOMORROW, START-OF-NEXT-WEEK) are not included because they are calculated 

internally by People-Trak. 

As you can see, the Periods column for the USER1-DAYS-BACK date variable is 

currently set at 120.  

This date variable will be converted to a date exactly 120 days before today’s date. 

Because we only need to look back 45 days, this needs to be fixed. 

3. Change the number in the Periods column to 45.  

4. Close the Enterprise Setup screen, saving your changes. 
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Tutorial 9.3 – Derived Field Attendance Report 

Our next task involves changing attendance data for a few of our employees and then creating 

our attendance report. To make it faster and easier, we will use batch processing. 

1. On the Processing menu, select Attendance Batch by Employee and create a new 

batch. 

2. Enter 1006 in the Employee ID field and press ENTER to return Donald Stern’s full 

name. 

3. For the Account field select Illness. 

4. In the Start Date field, use the calendar popup button to select a date from four weeks 

ago and select OK.  

5. Use the same date for the End Date field. 

6. In the Amount field, enter 12. 

7. For the Absence Reason, use the popup to select Illness- Self. 

8. Continue using the same data on the next three rows, each time moving up the Start and 

End dates up by a week.  

You should have four different attendance transactions for Donald that are ready to be 

posted.  

You may have also noticed that once the last entry was entered into the grid, the 

following message was displayed:  

The amounts entered exceeded the current balance of 45 hours. 

This means Donald  has successfully violated company policy and used up more hours 

than he had available in his Illness account. Oops! 

9. Select OK to close the message and you will see that the Negative Balance field has 

been updated with an X. This serves to let us know that this specific entry will put 

Donald’s account balance in the negative once the batch is posted. 

10. Create another entry, this time for Julie Carrington. 

11. Use today’s date for the Start and End Dates and select the same Illness Account and 

Absence Reason that we used for Donald.  

12. In the Amount fields, enter 45. 

13. Post the batch and close out of the document viewer once the audit trail is displayed. 

14. Continue with the next tutorial. 

15. Create a new Adhoc Report and give it the name 45 Day Illness Overage and assign it 

to the Attendance explorer category and category. 

16. Select the Report Definition tab and select the following fields for our report:  
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Full Name 

Attendance History Account  

Attendance Start Date  

Attendance End Date  

Attendance Hours  

Attendance Lookback 

17. On the Full Name field, select a Sort Type of Eject. 

18. Clear the Repeat check box for the  Full Name, Attendance History Account  and 

Attendance Lookback fields. 

19. Set the Row Modifier to =  for the Attendance History Account, Attendance Start 

Date, Attendance End Date and Attendance Hours fields. 

20. On the Query tab, enter the equation shown below: 

Attendance Lookback   > 40    AND 

Attendance Start Date  * > USER1-DAYS-BACK  AND 

Attendance History Account * = ILL 

21. Run the report. 

For Donald and Julie we can clearly see which attendance account has been violated, the 

dates the violations took place, how many hours were used each absence, and the sum of 

their account overage.  

22. Save your changes and close all screens.  

23. Continue with the next tutorial. 
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This lesson covers how to use the advanced features of the Lookup screen.  

Tutorials 
Creating Custom Queries: shows how to use the Custom tab on the Lookup screen to 

perform lookups using single-line query equations. 

Creating a Favorite: demonstrates how to create a lookup favorite in the Explorer for use in 

the Lookup screen. 

Using Favorites: shows how to use the favorite that was created in the previous lesson. Also 

demonstrates how to use the query equations from the favorite for an advanced lookup. 

Using Lookup Options: shows how to use the lookup options that are available on the 

Options tab of the Lookup screen. 
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Tutorial 10.1 – Creating Custom Queries 

The Custom tab on the Lookup screen is used to look up records using a simple single-line 

query.  

1. On the Shortcut Bar, click Open Employee to start the lookup process.  

 

The Lookup Employee screen is displayed. 

2. Click the Custom tab.  

 

The Custom tab contains three fields: Field Name, Operator, and Contents. These three 

fields are used to perform single-line queries for record lookups. 

 

In the Field Name field, you can enter a field name if you know it by name or you can 

select the field by using the popup button. 

3. In the Field Name field, enter City. 

 

The Operator field is supported by a list of operators in the same way as the Query grid. 

The valid operators are determined by the type of field.  

4. In the Operator field, enter =. 

 

The Contents field takes on the edit attributes of the field specified. For the City field, 

this means that the Contents field is supported by the City table.  

5. In the Contents field, select any city from the table. 

6. Click Search to perform the search.  

 

The list box shows all of the records that match your query. You can select any record 

from the list or you can start another query.  

7. Instead of selecting a record, click Clear to clear the query. 

8. In the Field Name field, enter Hire Date.  

9. In the Operator field, enter >.  

 

Your cursor should be in the Contents field, which takes on the edit characteristics of a 

date field, so both date popup buttons are available. 

10. Use either popup button to select any date or date variable. 

11. Click Search to perform the search. 

 

Now, let’s take a quick look at the Advanced tab. 

12. Click the Advanced tab. 

 

As you can see this tab uses the standard query grid. Like the Custom tab, this tab can be 

used for a custom query in the lookup process. The only difference is that this tab allows 

you to use a more advanced multi-line query. 
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13. Click Cancel to close the Lookup screen. 

14. Continue with the next tutorial. 
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Tutorial 10.2 – Creating a Favorite 

Favorites are queries that you create and save. A favorite is essentially a named query that 

you can recall when performing a lookup. This tutorial shows how to create a favorite. 

1. On the Documents menu, select Lookup Favorites.  

2. On the Tool Bar, click the New Lookup Favorite button to create a new lookup favorite.  

 

The Lookup Favorites screen is displayed. 

3. In the Lookup Name field, enter My Favorite. In the Explorer Category field, enter 

whatever category you desire. Leave the Category field set to User.  

4. On the Query tab, enter the following set of equations. 

 

Gender  = Male   AND 

(Age  > 30   OR  

Pay Rate > 3000.0000)   
 

You will recall that a similar set was used in an earlier lesson.  

5. On the Tool Bar, click the Run Lookup Favorite button to test the query. 

 

The test is a report that uses the standard lookup fields. 

6. Close the Document Viewer and the Lookup Favorites screen.  

7. Close the Explorer. 

8. Continue with the next tutorial. 
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Tutorial 10.3 – Using Favorites 

This tutorial shows how to use favorites. As an example, we will use the favorite created in 

the prior tutorial. 

1. On the Shortcut Bar, click Open Employee to start the lookup process.  

2. Click the Favorites tab. 

 

The list box on the Favorites tab shows all of the Lookup Favorites that have been 

created.  

3. Select My Favorite and click Search to perform the query associated with the favorite.  

 

The list of records presented should match the test report run when the favorite was 

created. In the future, additional records may be present as records change and then 

match the criteria of the query. The query associated with a favorite is dynamic. The 

query equations are executed when the favorite is processed. 

 

The results of a favorite are the same as the results of any lookup. You can select any 

record and return the entire group for editing. 

 

The query associated with a favorite can be modified “on the fly” if desired. When a 

favorite is executed, the query equations from that favorite are moved into the grid on the 

Advanced tab. (You do not normally see this because you are positioned to the Favorites 

tab.) If you wish to make a change to the query and to select records again, you can do so.  

4. Click the Advanced tab. 

 

You can see the query equations that you entered when you created the favorite.  

5. Modify the first line to look for Female instead of Male. Click Search to perform the 

lookup.  

 

The list of records will change to reflect the new query. 

 

The query equations associated with the favorite are not permanently changed. We are 

merely taking advantage of the fact that the equations are loaded into the grid on the 

Advanced tab just as if they had been keyed by hand. 

6. Close the Lookup screen. 

7. Continue with the next tutorial. 
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Tutorial 10.4 – Using Lookup Options 

This tutorial shows how to use the lookup options that are available on the Options tab of the 

Lookup screen. We will first look at the spanning option, which allows you to do a lookup 

across companies. It is only available to Administrators for security purposes. 

Let’s transfer a record over to the ARCHIVE company so we can then demonstrate the 

spanning option.  

1. Open Anna Belamonte’s record. On the File menu, select Transfer Employee. Transfer 

the current record to the ARCHIVE company. Close any open records to return to the 

Organizer desktop. 

2. On the File menu, select Select Company and switch to the ARCHIVE company. Open 

Anna’s record to confirm that it has been transferred. Close the record and return to the 

ACTIVE company. 

3. On the Shortcut Bar, click Open Employee to start the lookup process.  

4. Click the Search button, which will return all records in the ACTIVE company since we 

have not specified any other conditions that must be met. 

 

Note that Anna’s record is not listed. 

5. Click the Options tab. 

6. Select the Span Companies on Search check box. 

 

This will span companies during the current lookup. Note that the Search button is 

disabled when on this tab. This is because the system doesn’t know which query you 

want to use. You must be on one of the other tabs that define a query to begin a search. 

We want to use the basic query. 

7. Click the Basic tab, and then click the Search button.   

 

This time you will see Anna’s record included in the search results because all companies 

have been included in the lookup. Also notice that the Company column has been added 

to the search results. 

8. Select Anna’s record by highlighting it in the list and clicking OK.  

9. Click Yes when asked if you want to switch to the ARCHIVE company. 

 

Anna’s record is opened. In the Navigation Bar, note that the Record Counter located 

between the blue arrows says 1 of 1. Not only did just this one record get opened, the 

company was also switched to ARCHIVE (notice the Archive Company text in the 

header). This is necessary because you cannot edit a record from the ARCHIVE company 

while in the ACTIVE company. 

 

Note: In our example, there was only one record from the ARCHIVE company in our 

search results. If there was more than one record in the ARCHIVE company included in 

the search results, all of those ARCHIVE records would have been opened as a group and 

Anna’s record would have been the active one. If the One Record option was also 

selected, then only Anna’s record would have been opened. We’ll learn more about that 

option in just a bit. 
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10. Close Anna’s record. 

11. Return to the ACTIVE company. 

12. On the Shortcut Bar, click Open Employee to start the lookup process. 

13. Click the Options tab. 

14. Select the Span Companies on Search check box. 

15. Click the Basic tab, and then click the Search button.  

 

You should see both ACTIVE and ARCHIVE records in the search results. Note the 

number of records. 

16. Highlight a record in the list from the ACTIVE company, which is our current company, 

and then click OK.  

 

The highlighted record is opened. Note that the Record Counter does not say 1 of 1. The 

records in the search results have been opened as a group and your highlighted record is 

just the current record being displayed. Also note that the number of records opened does 

not equal the original number in the search results. This is because only records from the 

ACTIVE company were opened as a group. As we saw before, we cannot open records 

from the ARCHIVE company while in the ACTIVE company. 

17. Click the blue Next button to the right of the Record Counter to verify that there are 

indeed other records that have been opened. 

18. On the Tool Bar, click the Open Employee button to close the current group of records 

and start a new lookup process. 

19. Click the Options tab. 

20. Select the Single Record on Select check box. 

21. Click the Basic tab, and then click the Search button. 

22. Highlight a record in the search results and then click OK. 

 

This time, only the highlighted record is opened. The Record Counter should say 1 of 1.  

 

As you have seen, you have the option of returning just the highlighted record or all 

records in the search results. Each new lookup defaults to having the Single Record on 

Select check box cleared, which means all records in the search group will be returned.  

23. Close the record. 

24. On the File menu, select Select Company and switch to the ARCHIVE company. 

25. Transfer Anna’s record from the ARCHIVE company back to the ACTIVE company. 

26. Switch back to the ACTIVE company. 

27. This concludes this tutorial and lesson. 
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This lesson covers other document types that are available in People-Trak: Standard Reports, 

Cluster Reports and Freeform Reports. It also covers the Spanning tab and Description field 

on the Document Properties screen. 

Tutorials 
Standard Reports: shows how to create a standard report, which is a report with a pre-

defined format. Also shows how you can change the query for a standard report. 

Cluster Reports: demonstrates how to create a cluster report, which is a report that allows 

you to run several documents together as a group. 

Freeform Reports: shows how to create a freeform report, which allows you to enter an 

SQL statement and a series of captions to create reports that you could not otherwise create. 

Spanning: demonstrates how to use spanning of companies on a document. 
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Tutorial 11.1 – Standard Reports 

Standard Reports are those reports that have a pre-defined format. You can determine what 

employee records are to be included in the report, but the layout of the report is already set. 

Let’s create a standard report. 

1. On the Documents menu, select Standard Reports. 

 

The Explorer for Standard Reports is displayed. 

2. On the Tool Bar, click the New Standard Report button to create a new document. 

3. In the Document Name field, enter My Gender Graph. In the Explorer Category field, 

enter whatever category you desire. Leave the Category field set to User.  

 

A standard report document is composed of a standard report template and a query 

(which could be blank). So, we must select a report template in the Standard Report field. 

4. In the Standard Report field, click the popup button to display a list of the existing 

report templates. Select the Workforce Distribution by Gender template.  

5. Click the Query tab. 

 

As expected, there are no query equations. So, if we run the report, we will see all records 

in the current company, including those that might be terminated or inactive.  

6. Run the standard report. 

 

The report is a pie chart that graphically indicates the gender makeup of the company. In 

this instance, it is all employees in the company regardless of status.  

7. Scroll down to see the details that support the graph.  

8. Close the Document Viewer.  

 

Now, let’s enhance the document by adding a query. 

9. On the Query tab, enter the simple equation shown below. 

 

Gender  = Male 

 

This query will limit the employee records in the report to those whose Gender is Male. 

10. Run the report. 

 

The graph should indicate that a report that queries only males should list only males. 

11. Close the Document Viewer.  

12. This time, change the query to the more meaningful equation below.  

 

Active  = Y 

13. Now run the report.  
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This report will provide a chart with all currently active employees. Now that’s a useful 

report. 

14. Close the Document Viewer and the Standard Reports screen. 

15. Close the Explorer. 

16. Continue with the next tutorial.  
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Tutorial 11.2 – Cluster Reports 

Cluster Reports allow you to run several documents together as a group, without having to 

select and run each document separately. This feature is particularly valuable if you tend to 

run a series of documents at the end of each month, or merely on a frequent basis.  

1. On the Documents menu, select Cluster Reports. 

 

The Explorer for Cluster Reports is displayed. 

2. On the Tool Bar, click the New Cluster Report button to create a new document. 

3. In the Cluster Name field, enter Monthly Reports. In the Explorer Category field, 

enter whatever category you desire. Leave the Category field set to User. 

4. On the Documents tab, click the popup button. 

 

The Select Document screen is displayed. Notice that Cluster Reports is not listed in the 

list of document types in the upper left pane. This is because cluster reports cannot 

include another cluster reports. You can choose from all other document types. We will 

select an Adhoc Report. 

5. Stay in the currently highlighted Adhoc Reports type. Select the Compensation 

category in the list of categories in the lower left, and then select the Salary History by 

Employee document in the list on the right. Click OK to return that document to the 

Documents grid. 

 

Let’s add two more Adhoc Reports to our cluster report. 

6. On the next row of the grid, use the popup and select the Attendance Balances by 

Account document from the Attendance category. Keep going and add the Headcount 

by Department document from the Headcount category. 

 

We can mix document types in a cluster report. Let’s add a letter. 

7. On the next row of the grid, use the popup and select Letters in the list of document 

types. Now, select the Welcome Letter document in the list on the right. Click OK to 

return that letter to the Documents grid.   

8. Run the cluster report.  

 

Each document is processed independently and you may be able to see the progress bar 

for each. When the documents are complete, they are merged together and then shown 

within the Document Viewer.  

 

The documents are discrete within the Document Viewer. The page counter on the Tool 

Bar reflects the total number of pages in the cluster report, but each document’s pages are 

numbered from 1 to the total number of pages in the document. Font settings, alignment, 

spacing, and grid lines are all unique to each document.  

9. Move through the pages of the cluster report and you can see that each document is 

unique.  

 

Letter, Label and Form documents will not include a Navigation Bar because a cluster 

report can include several different types of documents. The Cluster Report feature is 
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intended to provide an easy way of outputting several documents; it is not intended to be 

used for interactive purposes. In addition, the Output to Spreadsheet option is not 

available. 

 

If you choose to print the cluster report, one stream of pages will be printed. 

10. Close the Document Viewer and the Cluster Reports screen.  

11. Close the Explorer. 

12. Continue with the next tutorial.  
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Tutorial 11.3 – Freeform Reports 

Freeform reports allow you to enter an SQL statement and a series of captions to create 

reports that you could not otherwise create. Normal use of this feature requires specific 

knowledge of SQL and internal knowledge of the People-Trak database. Such knowledge is 

beyond the scope of this tutorial, but we can show how the feature works and what you can 

do with it.  

The Freeform Reports feature bypasses all field security. If a user is allowed to create a 

freeform report, they can access any field within People-Trak. For this reason, there are 

special security settings for the freeform reports feature. We’ll explore these first. 

1. On the Setup menu, select Security Setup. 

 

On the General tab, there are two fields that control use of the Freeform Reports feature. 

The Create Freeform Reports field grants the ability to create these reports, and this is the 

ability that must be carefully used. If a user can create Freeform Reports, they can view 

virtually any information in People-Trak. 

 

The Run Freeform Reports field grants the ability to run freeform reports, but not to 

create them. So, it is possible to have some users with appropriate clearance create 

reports that can then be run by other users. Of course, it is important that the reports that 

are given to other users do not contain protected information. 

 

In order to see how these security settings work, we need to have the DEMO user not be 

an Administrator because an Administrator bypasses all security settings. 

2. Clear the Administrator check box for the DEMO user. 

3. Clear the Create Freeform Reports and Run Freeform Reports check boxes. 

4. Close the Security Setup screen, saving your changes. 

5. Open the Documents menu. Note that Freeform Reports is not listed as an option. 

6. Return to Security Setup and select the Create Freeform Reports check box for the 

DEMO user. Close the Security Setup screen, saving your changes. 

7. Open the Documents menu. Note that Freeform Reports is now listed as an option. 

Select Freeform Reports and let’s get started. 

8. On the File menu, select New Freeform Report or on the Tool Bar, click New 

Freeform Report. 

 

The Freeform Reports screen is displayed. This screen contains three tabs. The 

Specification tab is similar to the Adhoc Reports screen. The SQL Statement tab contains 

a single text box for entering the SQL statement. The Report Captions tab contains a grid 

for entering captions and formatting formulas. 

9. In the Document Name field, enter SQL Test Report. In the Explorer Category field, 

enter whatever category you desire. Leave the Category field set to User. 

10. On the SQL Statement tab, enter the following SQL statement. 

 

Select Name_Last, Name_First from PMMain 
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11. Run the report.   

 

Can’t find the Run option? There is a good reason for this. You still have the Run 

Freeform Report check box cleared for your DEMO user in Security Setup. This means 

you cannot run Freeform reports. Let’s change that. 

12. Close the Freeform Reports screen, saving your changes. Close the Explorer. 

13. Return to Security Setup and select the Run Freeform Reports check box for the 

DEMO user. Close the Security Setup screen, saving your changes. 

14. On the Documents menu, select Freeform Reports. Open your SQL Test Report 

document and then run it.  

 

This report lists the last name and first name for each employee in the database. There 

was no restriction on companies, so all employees in all companies are listed. (SQL 

statements are a type of programming; they do what you tell them to do and nothing 

more.)  

 

As you can see in the Document Viewer, there are no captions in the report. We can fix 

this.  

15. Close the Document Viewer. 

16. On the Report Captions tab, enter two Captions: Last Name and First Name.  

 

The two fields on our report do not need any formatting, so we will leave the Format 

column blank. 

17. Run the report again.   

 

It should look much better with these captions.  

18. Close the Document Viewer.  

 

As indicated above, there is insufficient scope to teach SQL, but to whet your appetite to 

learn more on your own, we’ll show a few other tricks.  

19. On the SQL Statement tab, clear the existing SQL statement, and enter the following:  

 

Select Avg(Age) from PMMain 

 

This statement will calculate the average age of all employees.  

20. Run the report.  

 

You can see that there are two problems. First the caption is wrong and second, there are 

too many digits to the right of the decimal point. We can fix both.  

21. Close the Document Viewer.  

22. On the Report Captions tab, change the first Caption to Average Age and delete the 

second Caption. Set the Format column for the first row to “#.00”.   

 

This will simplify the display to just two decimal places. 
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23. Run the report and you can see the fruits of your efforts.  

 

The combination of SQL statements and People-Trak formatting capabilities can allow 

those with a working knowledge of SQL to create a very wide range of reports. In certain 

instances, your Support Representative will provide a Freeform Report solution for you 

should the two of you be unable to create the desired report with the Adhoc Reports tool. 

24. Close the Document Viewer, the Freeform Reports screen and the Explorer. 

 

Before we leave, we need to get DEMO set back to Administrator. 

25. Return to Security Setup and select the Administrator check box for the DEMO user. 

Close the Security Setup screen, saving your changes. 

26. Continue with the next tutorial. 
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Tutorial 11.4 – Spanning 

Now we are going to switch gears a bit and look at document properties that you have not yet 

learned about. The first one is document spanning where you can have documents span 

multiple companies at your discretion. Here is how you do it. 

1. On the Documents menu, select Adhoc Reports. 

2. Create a new Adhoc Report named All Employees and place it in any Explorer 

Category you desire. Leave the Category field set to User. 

3. Leave the Query tab blank, but add two fields to the Report Definition tab: Employee 

ID and Full Name. Add a Count calculation on the Full Name field so that we can count 

the records.   

4. Run the report and note the number of records that qualify.  

5. Close the Document Viewer and the Adhoc Reports screen. 

 

Your new report should be highlighted in the Explorer. 

6. On the File menu, select Adhoc Report Properties or on the Tool Bar, click the Adhoc 

Report Properties button to display the properties for this document. 

 

The Adhoc Report Properties screen is displayed for this document. 

7. Click the Spanning tab.  

 

This tab provides a grid in which to record the companies that are to be spanned. In this 

case, the grid is blank. When you ran the report, however, records were displayed and 

counted. Why? Because when there is no company specified, the report will be run for 

the current company only. Once you specify one or more companies, the report will be 

run for those companies regardless of which company is the current company. 

8. Close the Adhoc Report Properties screen and close the Explorer. 

9. Use what you already know to transfer the following three records from the ACTIVE 

company to the ARCHIVE company. 

 

1017 Anna Belamonte 

1019 Helen Pilsner 

1020 Renee Watanabe 

10. Close any open records to return to the Organizer desktop. 

11. On the File menu, select Select Company and switch to the ARCHIVE company. 

Confirm that the three records have been transferred. Return to the ACTIVE company. 

12. On the Documents menu, select Adhoc Reports. 

13. Find and highlight the All Employees report you created earlier in this lesson. Run the 

report from the Explorer.  

 

There should be three less records than there were before because we moved three 
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records from the ACTIVE company to the ARCHIVE company, and we are currently in 

the ACTIVE company. 

14. Close the Document Viewer and the Explorer.  

15. On the File menu, select Select Company and switch to the ARCHIVE company. 

16. Open your report and run it again.  

 

How many records are shown this time? There should be as many records as there are in 

the current company, which is the ARCHIVE company. 

17. Close the Document Viewer.  

 

You can also access the Adhoc Report Properties screen from within the screen for the 

report itself. 

18. On the Adhoc Reports screen, use the Adhoc Report Properties option on the File 

menu or the Adhoc Report Properties button on the Tool Bar to display the Adhoc 

Report Properties screen. 

19. Click the Spanning tab. On the first line in the grid, click the popup button to display a 

list of the available companies. Select the ACTIVE company. Close and save the 

changes to the properties. 

20. Run the report again.  

 

This time, how many records are shown? Even though we are currently in the ARCHIVE 

company, all of the records from the ACTIVE company are shown because that is what 

the spanning instructions state. 

21. Open the Adhoc Report Properties screen again. On the Spanning tab, add the 

ARCHIVE company to the list of companies for our sample report. Close and save the 

properties. 

22. Run the report again.  

 

This time, all of the records in the ACTIVE and the ARCHIVE companies are shown. 

This will be true regardless of the company you are currently working in even if it is not 

one of the companies in the spanning list. 

23. Finally, use the Adhoc Report Properties screen to remove both of the companies from 

the spanning list. Now, run the report again, and it will contain the employees from the 

current company only. 

24. Close the Document Viewer, the Adhoc Reports screen and the Explorer. 

25. Transfer the three employees from the ARCHIVE company back to the ACTIVE 

company. 

26. Switch back to the ACTIVE company.  

 

Spanning is only available to Administrators for security purposes, so when non-

administrators run a document that spans, they will only see information for the current 

company and based on their given security. 
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27. Exit People-Trak. 

28. This concludes this tutorial and lesson. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


